Downloading Your
Financial Statements
to Excel

Downloading Data from CU*BASE to
PC

INTRODUCTION

How can I get my favorite financial statement from CU*BASE into my Excel
worksheet? How can I get this data in a way that I makes it easy to perform
calculations and format the results for to make prettier presentations?

Independent PCs, LANs and WANSs are a critical part of the online CU*BASE
environment. More and more, day-to-day credit union activities require that
one of your most important assets—data—be available for analysis and
manipulation on a platform other than CU*BASE.

To that end, we are pleased to provide ability to download your financial
statements from within CU*BASE directly to Excel. This option makes
translating data from CU*BASE to and Excel simple to do, giving you results
that you can immediately use to perform calculations and to format using
today’s most popular PC applications.
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CREATING THE FILE FROM WITHIN
CU*BASE

PREPARING THE FILE

In this step you begin in CU*BASE to select the financial statement report
that you would like to download into Excel as well as print out a printed

copy. Begin in Tool #640 Print CU Financials and select your report and
your parameters.

1. From this screen select Export to file & print report.

Session 0 CUFBASE GOLD Edition - FINANCIAL STATEMENT REPORT B o ]
File Edit Tools Help

FINANCIAL STATEMENT REPORT

Corp ID 1 ABC TESTING CREDIT UNION

Report # 2 INCOME STATEMENT - TRIAL BALANCE

Report Options Response

e 10 .Iob queue
Summarize locations Copies m

Single location # Opt fonal Printer
[#]Print zero balances

rint G/IL account #

[] Print accounting format
Printiview options

@Export to file & printreport () View on CRT () Report only

Report comment

Run/Next Report

Branch Selection

New Report

2. Name your exported results.

Session 0 CU*BASE GOLD Edition - EXPORT WINDOW
File name |

Export immediately File will be stored in your credit union's QUERYxx library (where xx is your 2-character CUID).

The next step is to take the database file created in CU*BASE Report Builder
and transfer it to a file stored on your PC.
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DOWNLOADING THE FILE TO THE PC

1. Once you select to download the file, the following screen will appear.
This screen is the data transfer wizard, also accessible from Tool #1375
Data Transfers (Upload or Download).

&3 Data Transfer - O *
File View Actions Help
1 % ZFromIBMi-2 ¥
IBMi
System: PROD.CUANSWERS.COM e
File name: QUERY x/DAILYBAL v Browse
Data Oplions
File
Qutput device; |File v Details
Mame: C:\rubasedownloads/file MMYY Browse
In the Name field,
replace MM YY with the Format Options
current month and year.
Spaces are allowed.
Start Transfer Stop Transfer Properties

2. Complete all of the following fields (none are case-sensitive):

Field Descriptions

Field Name Description
IBM These settings refer to where the data is coming from.
System This designates the iSeries system from which the files will

be downloaded. Enter your system name.
e Online Clients: PROD.CUANSWERS.COM
e Site-Four Clients: PROD.SITE-FOUR.COM

File name DO NOT use the Browse or Data Options buttons, they can
cause a significant delay in processing your transfer!

Enter your credit union’s Query library name, a forward
slash, then the name of the database file to be downloaded,
as in the following sample:

QUERYxx/FILENAME

(For the xx, fill in your credit union’s two-character credit
union ID)

File These settings refer to where the data is going.

Output device This setting controls the format in which the data will be
downloaded. Click [ Y] and choose File.
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Field Name

Description

Name

Enter the path (the storage location, both drive and folder)
and file name where the downloaded file should be stored on
your PC. Use backslashes between the folder name and the
file name, as in the follow sample:

C:\CUBASEDOWNLOADS\FILE MMYY

HINT: Locating downloaded files and keeping your
computer storage clean will be much easier if you
designate a special folder on your PC to receive all
downloaded files, such as c:\cubase, c:\downloads,
or something similar. To differentiate downloads,
add a date at the end of the filename by replacing
MMYY with the current month and year.

S. To begin the transfer process, click the Start Transfer button.

If you experience problems downloading, it may be because
you have not been authorized to receive downloads from
the CU*BASE iSeries. Downloading files from the CU*BASE
iSeries requires special security authorization by a
CU*BASE representative. If you or a member of your staff
needs to be able to download files, please contact a Client
Service Representative to set up the proper permissions.
Authorization by your credit union’s designated Security
Officer is required to grant these permissions and confirm
this clearance on a monthly basis.

6. When the transfer is complete, the following message will appear: Click
OK and the Data Transfer dialog box will reappear. Click Close [X] to
exit. (See below for details on saving the transfer request.)

\

Inquiry Message

Transfer request is complete.
Transfer statistics: 00:00:01
Rows transferred: 7,558

OK

NE

b

Notice the number shown under “Rows
transferred.” This indicates the total
number of records that were
downloaded and should match the
number of records found when running
the original report.

Also make sure that your spreadsheet
or other PC application can handle that
many rows of data!

The text file is now saved in the designated folder and can be opened in any

spreadsheet or other PC application.
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OPENING A DOWNLOADED FILE USING

MICROSOFT EXCEL

NOTE: The following is shown as an example only. For complete
information on using Microsoft Excel or any of the many popular PC
spreadsheet applications, refer to your software reference manual.

1. First, open an Excel workbook. Once you are in Excel, from the File

menu, choose Open.

& Open
+~ » ThisPC » 0S(C:) » cubasedownloads
Organize * New folder
Name Date modified Type
7t Quick access
@ 2013 Year End Guide Mailing List
a Microsoft Excel @ DAILYBAL
@ OneDrive 3 MeRLST
I This PC
¥ Metwork

Microsoft Excel W...
Microsoft Excel W...

Microsoft Excel W...

v | O Search cubasedownloads §e]

o @

28 KB
9KB
9KB

File name:

v| Al Excel Files

B35 T

Cancel

o

2. In the Files of Type list, choose All Files (*.*). Use the Look in list to

open the folder where the file was downloaded.

3. Select the file name to be opened, choosing the file without the *. FDFX

extension, then click Open. A series of windows will appear to help you

separate the text in the file into separate columns.

& 8o

If the Text Import Wizard does not appear, first

=F

Text to E!:
[t -

Columns c&

Data Tools

drag to highlight and select the data that you have
in column A (it is important to select only the
fields in column A with data, not using the header
to select the entire column). Once you have
selected the fields, click the Data tab, and under
the Data Tools section, select Text to Columns.

4. Select Delimited and click Next to proceed.

Downloading Your Financial Statements to Excel m




Text Import Wizard - Step 1 of 3

The Text Wizard has determined that your data is Fixed Width,
If this is correct, choose Mext, or choose the data bype that best describes vour data,
L Criginal data type
Se(l)?]ctth[i)sdslg?ét:r? Choose the file type that best describes your data:
' - Chatacters such as commas or tabs separate each field.
- Fields are aligned in columns with spaces between each field,

Skark impoart ak row: File origin: 437 1 OEM United States w

) Fixed width

Preview of File HVWCUBASEVAKMDOWN,

Ll ,. CURRENT, CURRENT, LAST YEAR, LAST YE&R,,,,,|™
= PERIOD, Y-T-Ir, PERIOD, ¥-T-D,,,.,

|2| INCOME,,.00O,.00,.00,.00,.00,.00,.00,.00,

|4| INCOME FROM LOANS,,.00,.00,.00,_ 00,.00,.00,.00,.00,

|5| 1, INT INCOME - SHARE PLEDGE LOANS,  103.76-,11388 30-,1369_ 4(..
<

bs

[ mext> ][ Ensh |

5. On the next screen, check the Comma checkbox, and select Next.

Text Import Wizard - Step 2 of 3

This screen lets wou set the delimiters vour data contains, You can see
hiowe your text is affected in the preview below,

Delimiters
[J1ab [ semicalon
[space [

[] Treat consecutive delimiters as one

Text gualifier:

On this screen,

check the Comma Data preview
checkbox.
CURRENT -
PERIOD
INCOME .o .00
INCOME FROM LOANS oo . oo
1 INT INCOME - SHARE PLEDGE LOANS Loz, 7e- h1zss {
< >

[ Cancel ” < Back ” Mext = H Finish

6. Click Finish on the next screen.
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Text Import Wizard - Step 3 of 3

This screen lets vou seleck each column and set Column data Format
the Diata Farmat. @) General
‘General' converts numeric values to numbers, date (O Text
values to dates, and all remaining walues to text, ) Date; | MOV “
() Do niot impart column (skip)
Daka preview
= Fannral GeperiCeneral Copcls
CURRENT 2
PERIOLD
INCOME muln] . oo
INCOME FROM LOANS muln] . oo
IHT IMCOME - SHARE PLEDGE LOANS Loz 76— L1388 ]«
4 b

[ Cancel ][ < Back ]

Once the data has been pulled into the spreadsheet, you may format it, add
headings, set up calculations, and perform any other spreadsheet function
you wish. Negative numbers arrive ready for calculations with a negative
symbol appearing with the number. Be sure to save the file as an Excel
document.

B3 Microsoft Excel - AKMDOWN

@_1 File Edit ‘iew Insert Format Tools Data  Window Help  PDF Create!  Adobe PDF -8 X
= L -0 -|B 7 U|ISEE=HEHS % [F-0-A- B
i bnl B T
0~ BT ! s !
A1 - &
A B | C | D | E | F | Gm

1 CURRENT CLURRENT LAST ¥l LAST

2 PERIOD Y-T-D PERIO W-T-[

3 INCOME 0 I} 0

4 INCOME FROM LOANS ] 0 0

5 [ 1 INTINCOME - SHARE PLEDGE LOAMNS -103.76 -11388.3 -1369.4 -3

B |2 IMTINCOME - SHARE PLEDGE LOAMNS -1.4 -62.55 -84.02

7|3 IMT INCOME - SHARE PLEDGE LOAMS -13.62 -857.09 -03 -

S |4 IMTINCOME - SHARE PLEDGE LOAMNS -11.64 171427 -284.7 -1

9 |5 IMTINCOME - SHARE PLEDGE LOAMNS 213 -295.79 0

10 1) INT INCOME - SIGNATURE LOAMNS -3166.19 -4BE97E5.09 9124653 -523
11 2 INT INCOME - SIGNATURE LOAMNS =229 23 -30931.69) -3484 49 -19
12 [ 3 INT INCOME - SIGNATURE LOAMNS -2837a8 415193 -6182.45 =32
13| 4 INT INCOME - SIGHNATURE LOAMNS -4585.93 Sf3F7A.58 1318827 -7
141 & IRIT INCORE - SUEKATLIRE | OARKNS a5 71 REFreEtl n b7
M4 b M AKMDOWN / |2 3
Ready I

MiscCELLANEOUS HINTS AND TIPS

Although downloaded data can be opened using a word processing
application, such as Microsoft Word, it is generally not recommended.
Remember that the file is a simple text file, with spaces to separate the
fields and no formatting. Choosing a proportionally spaced font, for
example, may make the data difficult to read.

If you wish to use the data as part of a mail merge (for personalized form
letters or mailing labels), open the data in a spreadsheet program and
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add one row at the top for the field labels. Then use your word
processing program to create the form letter, using the spreadsheet as
the database from which the variable information will be pulled.

e Data such as amounts, dates, ZIP codes, etc., can be formatted either
when the custom report is created, or after the data has been pulled into
your spreadsheet program, according to your preference.

e If upon opening the file you see a series of numbers and letters that
appear to be “garbage,” it is usually because the “Convert CCSID 65535”
flag was not checked when the download transfer was performed. Repeat
the download procedure, using File, Properties to select the conversion
option.

SAVING TRANSFER SETTINGS

If you perform file transfers often, one way to speed things up and make sure
that all settings are set correctly (especially the conversion format you
selected using the File, Properties command), the transfer request can be
saved. This feature simply stores all of the file names and other settings
from the Data Transfer window so that they can be quickly filled in for you
the next time a transfer is performed.

1. When closing the Data Transfer window after a transfer has been set up
or performed, the following message may appear:

Inquiry Message >
@ Do you want to save this fransfer request?

Yes Mo

If this is a transfer you perform often, click Yes.
OR

1. At any time in the Data Transfer window, choose the File menu, then
choose Save. If the transfer has not been saved before, the following
dialog box will appear:

HINT: If you have already saved the transfer once but wish
to use a different name this time, use File, Save As
instead.
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Save i | ) cubasedowninads j & 5 B

File name: |testingtlansfertosave
Save az lype: |Data Transfer From AS /400 files [* dif) ﬂ Cancel

2. Enter a name for the transfer request, then click Save. The request will
be saved.

USING A SAVED TRANSFER REQUEST

1. After creating the database file as usual, display the Data Transfer
window. (This is accessed via Tool #640 Print CU Financials).

2. From the File menu, choose Open, select the desired transfer request
from the list and click Open.

3. Make changes to the request specifics as needed (such as the PC file
name, etc.), then click Transfer data from AS/400 to begin the transfer
as usual.
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